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ABOUT THIS DOCUMENT
This document contains all necessary information on how to install and use LiveCut.
Before you start using LiveCut, we make these assumptions:

 ρ You are familiar with the Macintosh environment.
 ρ After reading this document you understand how to use LiveCut.

1 ABOUT LIVECUT
LiveCut speeds up your multi-camera production environment by centralizing ingest, metadata logging 
and take handling in a simple-to-use user interface. It also records an EDL (Edit Decision List) from the 
switcher, which is transferred to a multi-camera sequence in your preferred NLE.

Trimming, re-editing, slip & slide are available a few seconds after the recording is done.

Specifications
 ρ Video: Handling of up to 16 SDI sourced channels (8 video streams per USB interface).
 ρ Audio: Must be embedded and can reach a maximum of 8 channels per channel.

ABOUT LIVECUT

SETUP OF A LIVECUT SYSTEM1.1 

A LiveCut system consists of two main components:

 ρ 1. The ToolsOnAir just:in multi engine for the native ingest process.
 ρ 2. The LiveCut application from where everything – including the native ingest process – is handled.

You can set up the whole system to run on a single Mac, or decide to divide ingest and the LiveCut 
controller application to be on separate Macs. Even editing on the same machine is possible. Depending 
whether you plan to have only one Mac or split up the system, you will have different hardware 
requirements, which will be treated in the following chapters.
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2 SYSTEM REQUIREMENTS
Macintosh Model Mac Pro 5.1

Operating System Mac OSX 10.8.2 or higher. Administrator account required for installation.

Video Ingest Device Blackmagic DeckLink cards with driver version 9.6.4 or later.

Connectivity At least three free USB ports for the LiveCut USB Interface, the keyboard and 
mouse.

Screen At least 20 inch.

Supported NLEs Apple Final Cut Pro 7.0.3, Apple Final Cut Pro X 10.0.5, Adobe Premiere Pro 
CS6, Avid Media Composer 6.0.1 (later software versions are also supported).

If you plan to edit and/or ingest on the same Mac, make sure it complies with the corresponding system 
requirements of your ingest & NLE.

3 INSTALLATION
Before you begin installing LiveCut, make sure to install the latest driver for you Blackmagic video 
device first. Visit http://www.blackmagicdesign.com to download the latest driver.

Now open the LiveCut installer package. Click the "Continue" 
button in the install window and proceed with the following 
steps. When the installer has successfully finished, click the 
"Close" button.

After installation the application parts are located at (where "~" is your home directory):

 ρ LiveCut: /Applications/LiveCut/LiveCut.app
 ρ Just In Engine QuickTime: /Applications/LiveCut/Just In Engine QuickTime.app
 ρ Just In QT Preference Pane: ~/Library/PreferencePanes/Just In QT.prefPane

Note

In case of a previous activation of any version prior to this v1.3 LiveCut, you will need to 
enter a new activation code. Please contact ToolsOnAir to receive your updated activation 
code.
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4 SETUP WITH JUST:IN MULTI
Before starting LiveCut, you need to configure the "Just In 
QT" preference pane in the System Preferences of your Mac. 
The different configuration options will be outlined below.

On the left side you can see all the video capture devices found by the engine, as well as the names 
given to those devices. Select a device to configure it.

6

2

3

4

5

7

1

1 Capture Devices
Lists all video capture devices found by the engine.

2 Name
Define a channel name.

3 Device
Shows the manufacturer. Intentionally left blank.

4 Video Mode
Configure the video device. The available video mode settings for the previously selected engine 
framerate will be displayed automatically.

5 Audio Bitrate
Selectable 16- or 24-bit for Blackmagic cards.

6 VTR Control / VTR Preroll in Seconds
Not supported when using LiveCut.

7 Chunk Length
LiveCut does not support chunk capturing, therefore the chunk length defined here is the predefined 
capture length. It must not be changed while recording. Make sure your have chosen the desired 
chunk length before recording. If you have multiple channels, the length of the channel with the 
shortest value will be selected.
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9

8

10

11

13

12

8 Start Timecode
Do not change this setting when using LiveCut.

9 Cache Options
Normally files are written to disk in a stream (no caching, default). You can ask the HDD-Controller 
to cache data in order to flush them later to disk to improve write performance. Change this value 
to "Cache" if you experience low write performance, otherwise keep the default "Don’t Cache" 
setting.

10 Video Output Buffer
Number of A/V frames to flush to the storage system at once. If you want to flush once a second, 
just enter your video framerate.

11 Output Buffer Segments
Number of buffer segments. The number of segments multiplied by the storage flush size is the 
total buffer size. Be careful when using that feature, as you can run out of RAM. It is recommended 
not to exceed a total buffer size of 500.

12 Engine Port
When using "Publish Bonjour service" it is "0" by default. Please enter a dedicated port number, if 
you want a channel to be accessed over IP. Consult your network administrator for port availability. 
When selecting "Local Mode" it will default to port number 65010.

13 Local Mode
Not supported when using LiveCut.

Note

Version 1.6 of just:in highly improves the writing frequency/load behavior on Xsan and 
other similar storage systems. This is done by specifying the frames per flush and storage 
buffer size. The frames per flush value defines after how many frames the chunk will be 
written to disk, the storage buffer size defines how many chunks are possible. The total 
size of the buffer is calculated by multiplying these two values (see "Video Output Buffer" 
and "Output Buffer Segments" settings on this page).
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CONFIGURATION BEFORE USING LIVECUT

CAPTURE PRESETS4.1 

Define your capture presets here. Once you have defined your preset, click the "Save" button and enter 
a name for it. Make sure that you save this preset to "/Library/Application Support/ ToolsOnAir/Just In". 
Do not use one or more of the following characters: / @ : | \ < >.

1

2

4

6

3

5

7

1 Preset
The name of the capture preset.

2 Timecode Source
Timecode sources can be Computer Time, VTR (over RS-422), LTC over Audio, Miranda Little 
Red LTC, Capture card LTC or SDI Embedded.

3 TV Norm
Set a TV norm here as required (PAL, NTSC, HD).

4 Container
Choose between either QuickTime or MXF.

5 Aspect Ratio
Configures the aspect ratio (4:3 or 16:9).

6 Codec
Choose from a list of available codecs for the selected container (QuickTime or MXF).

7 Audio Channels
Select the number of audio channels and the audio track alignment (Mono or Stereo) you would 
like to capture.
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CONFIGURATION BEFORE USING LIVECUT

DESTINATION PRESETS4.2 

You can use just:in destination presets in LiveCut. To do this, select a path for each file you want to 
save and click the "Save" button. You will then be prompted to enter a preset name. A destination preset 
consists of the following options:

2

1

3

4

/Volumes/RAID1/HiRes

/Volumes/RAID1/Proxy

/Volumes/RAID2/HiRes

/Volumes/RAID2/Proxy

1 Preset
The name of the destination preset.

2 Path
Enter the path where you want to store the HiRes movies.

3 Proxy Path
Enter the path where you want to store the proxy movies.

4 Path fallback / Proxy Path fallback
Not supported in LiveCut.

Attention

You must save both – capture and destination presets – to this folder:
 ρ  "/Library/Application Support/ToolsOnAir/Just In"

Note

If you choose a different destination path for the HiRes and the Proxy, the resulting clip 
name will be the same. Otherwise "_PROXY" will be automatically added to the clip name.
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CONFIGURATION BEFORE USING LIVECUT

PRESETS: APPLE PRORES 422 AND AVID DNXHD4.3 

Apple ProRes 422

When using the Apple ProRes 422 codec you will be 
prompted to select a framerate and resolution.

Avid DNxHD

When using the Avid DNxHD codec, you will be prompted 
to select a resolution and the appropriate Color Level 
(RGB or 709). Please make sure that you are using a 
recommended machine (see page 2) to ingest DNxHD 
material.

CONFIGURATION BEFORE USING LIVECUT

ACTIVATION4.4 

Pressing the "Request" button opens the default email 
application and prepares an email with the machine ID 
which you can then send to ToolsOnAir.

Once you have received the "Activation Code", you can 
enter it in the appropriate field.

Notes
 ρ just:in multi and LiveCut already have the ability to ingest into an MXF GC, D-10, 

container built-in. Because of license agreement contracts you will have to contact 
MXF4mac (licensing@mxf4mac.com) though, in order to receive a free of charge 
license to use their technology. Just take a screenshot of the TOA activation preference 
pane tab and send it to MXF4mac. They will be more than happy to issue you a license 
file promptly. 

 ρ just:in multi and LiveCut can ingest into an Avid OP-Atom MXF container right away 
without a dedicated license.
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5 USB INTERFACE
The USB interface connects LiveCut to your switcher (the term "switcher" will be used for whatever 
switching- or routing device you use). Connect the "ServiceUSB Interface" to a free USB port after 
installing LiveCut.

USB INTERFACE

TECH SPECS5.1 

Dimensions 
(LxWxH)

17.5 x 10.5 x 5 cm / 6.89 x 4.13 x 1.97 inch

Weight 530 gram (18.7 oz.)

Materials Aluminum, Acryl, IP30

External Power 
Supply

 ρ Input voltage: 100–240 volt AC, Input frequency: 50–60 Hz
 ρ Output voltage: 12 volt DC, 20 watts

Connectivity  ρ 1x USB-B (cable included)
 ρ 1x Power (cable included)
 ρ 21 Cage clamps (from 0.08 to 2.5 mm2, all I/Os)
 ρ 1x D-Sub 25 (all I/Os)
 ρ 1x D-Sub 9/RS-232 (for future use)

More technical information is available upon request.

USB INTERFACE

HOW TO MOUNT5.2 

In general the interface is meant to be fixed by a metal angle (not 
supplied) in the back of a 19" rack. The USB interface can be 
disassembled for hole drilling. These holes can then be used for 
fixing. 

 

Attention

Do not drill holes into the USB interface housing without disassembling it, otherwise you 
could harm electronics inside of the housing.
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USB INTERFACE

INDICATORS / LEDS5.3 

The USB interface has different lamps and LEDs:

 ρ LEDs indicate if the connections are working. LED #0 refers to source 1, LED #1 refers to source 2 
… LED #n refers to source n+1.

 ρ USB lamps indicate the USB connection to controller.
 ρ The "12V" lamp is only active when connected to an external power source. 

If negative input logic is used, the current active input is off instead of on. If no input is used when the 
interface is connected to the Mac, input 7 will be active.

USB INTERFACE

CONNECTING THE SWITCHER5.4 

 ρ GPO/Tally: LiveCut comes with a custom built switcher cable which connects your GPI capable 
switcher and the LiveCut USB interface.

 ρ Blackmagic ATEM: If you have purchased the LiveCut ATEM package and therefore use Blackmagic's 
ATEM series, no USB interface is required (i.e. no USB interface will be shipped with the system).

USB INTERFACE

CAGE CLAMPS5.5 

The cage clamps should not be used in a proper LiveCut 
setup, but they are a good way to test the functionality of the 
box in case of a support case. 

Their label is printed on the circuit board. To insert a wire, 
firmly press the lever down and insert the wire, then release 
the lever to fix it. Make sure the cables are secured so they 
cannot be pulled out.
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USB INTERFACE

TALLY OUT CABLING5.6 

The output of the USB interface can be used for tally light operations. When doing so, the interface 
needs to be supplied with external power. The tally lights should not exceed more than 10 watts each.

If needed, ToolsOnAir can customize the main GPI switcher cable upon request , as it's all connected 
through the DB-25 connector on the USB interface.
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6 LIVECUT INITIAL STARTUP
LIVECUT INITIAL STARTUP

LIVECUT FOLDER STRUCTURE6.1 

When the LiveCut application is started, a folder named "LiveCut Documents" is created in the 
"Documents" folder of the current user ("~/Documents/LiveCut Documents"). It hosts several 
subfolders:

Exported AAF Projects Holds AAFs exported from LiveCut (if Media Composer is chosen 
as video editor, this folder is initially not visible, but is automatically 
created when you make your first export).

Exported Final Cut Projects Hosts the Final Cut Pro 7 project files.

High Res Files Ingest target folder for high resolution files.

High Res XML Backups Contains exported XML files, linked to high resolution media files.

Project Templates Holds the LiveCut project templates.

Projects Holds the project files generated by LiveCut.

Proxy Files Ingest target folder for low resolution proxy files.

Proxy XML Backup Contains exported XML files, linked to low resolution proxy files.

Note

This structure can be modified from within LiveCut, nevertheless it is strongly re com-
mended to only change the target folder of the ingest (e.g. change to a SAN volume).

LIVECUT INITIAL STARTUP

LIVECUT STARTUP6.2 

LiveCut will ask you for "Name", "Scene" and "Take" whenever started. Enter the appropriate info (if you 
are just doing a setup, use dummy names). No presets are installed, so you won´t be able to choose 
one yet.
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7 LIVECUT PREFERENCES
Before using LiveCut you need to properly configure 
its preferences. Open the menu "LiveCut" and select 
"Preferences…" or press "cmd + comma" to bring up the 
preferences window. 

LIVECUT PREFERENCES

VIDEO EDITOR7.1 

This setting defines the NLE you are going to export to. 
Depending on the selected value in the "Video Editor" drop-
down menu, the export format is automatically chosen 
(AAF or XML).

LIVECUT PREFERENCES

I/O DEVICE: INPUT7.2 

I/O Device
Selects the connection type to your switcher. 
Values are "Service USB" or "ATEM Switcher".

Service USB
Connects the switcher through GPOs (slave mode).

Negative Input Logic
Enable "Negative Input Logic" if your switcher 
requires it (usually when using an open collector 
connection).

Input/Input Mappings
The matrix maps GPI-ports to sources within 
LiveCut. The matrix gets very useful when doing 
more complex setups. We recommend not to 
change anything as long as you are doing simple 
setups (iso only).

Note: After changing the "Input" tab configuration, you will have to press the "Apply" button and restart 
the LiveCut application for any changes to take effect.
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LIVECUT PREFERENCES

I/O DEVICE: OUTPUT7.3 

Configures the GPI-Outputs. Just set "Negative 
Output Logic" to the same value as in the "Input" 
tab.

You don't have to change anything else here, 
when not using the outputs for controlling tally 
lights.

Note: After changing the "Output" tab configu-
ration, you will have to restart the LiveCut appli-
cation for any changes to take effect.

LIVECUT PREFERENCES

I/O DEVICE: MISC7.4 

Choice of the first source in your EDL.

 ρ Use first source selected: Takes over the first 
source sent by your switcher into your EDL.

 ρ Use source: Lets you choose between 1 and 16 
as a fixed first source in your EDL.

Note: After changing the "Misc" tab configu ration, 
you will have to restart the LiveCut application for 
any changes to take effect.
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LIVECUT PREFERENCES

I/O DEVICE WITH BLACKMAGIC ATEM: INPUT MAPPINGS7.5 

Blackmagic ATEM
The ATEM series switcher can be controlled from 
within LiveCut (master & slave mode) by simply 
entering the IP-address of the switcher.

Use first source selected
Takes over the first source sent by the ATEM 
switcher into your EDL.

Use source
Lets you choose between 1 and 16 as a fixed first 
source in your EDL.

Input Mappings
The matrix maps your ATEM switcher to sources 
within LiveCut. The matrix gets very useful when 
doing more complex setups. We recommend not 
changing anything as long as you are doing simple 
setups (iso only).

LIVECUT PREFERENCES

I/O DEVICE WITH BLACKMAGIC ATEM: KEYBOARD SHORTCUTS7.6 

Defines keyboard shortcuts to directly switch sources 
from within LiveCut and toggle fades and their duration.
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LIVECUT PREFERENCES

TIMECODE7.7 

Timecode Offset (Frames)
Defines the technically possible delay between the 
EDL and the QuickTime file (due to hardware related 
components). Leave it on 0 as long as there is no 
measurable delay.

Allow Dissolves
Enable this if you want dissolves in your se  quence. 
When enabled, you will have to set the dissolve 
tolerance for the GPI triggers. Recommended is 
a tolerance of about four frames. Some relays are 
acting slow regarding the physical switching, so 
there might be an issue when doing cuts. They will 
show up as fast dissolves. This settings prevents 
LiveCut to do so.

Timecode Server
Select the computer time for test and demo 
environments but also if you don't need or 
have an external TC generator and only work 
on a single Mac. Choose "Audio In" and choose 
any Core Audio source of your Mac to connect 
an external LTC. If your Mac does not have an 
audio input, simply connect through any other 
third party device (e.g. "Griffin iMic") to get a 
simple LTC input.

LIVECUT PREFERENCES

JUST:IN7.8 

Ingest (currently not available, but will come back soon)
This selection let's you choose if you want to record the 
EDL (set ingest to "None") or use just:in as ingest.

Preview Channels per Row
Defines how your recorder window will look like,
e.g. four preview channels in one row or in two 
channels in two rows.

Use a single directory
Choose this for standard environments where all 
your channels are captured to the same storage. 
This is the easy and default setup.

Use Just In Destination Presets
Choose this if you need to capture the channels to different volumes. This is mainly used when capturing 
to more than four HD sources or some uncompressed sources (e.g. green screen) to high-end storage, 
whilst compressed sources are captured to mid-range storage solutions.
Limitations when using Avid Media Composer 6: You will have to use ToolsOnAir's just:in ingest solution to capture to 
OPa MXF files including proper UMIDs (Unique Material Identifier) which are used to reconnect media files and timelines 
within Avids's Media Composer.
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LIVECUT PREFERENCES

MARKERS7.9 

1

3

2

1 Shift new markers by (frames)
When creating new markers you can use this setting to shift them to be closer to the event you 
marked.

2 Add Frames before/after marker (not usable when using Media Composer)
You can export a certain marker – even while recording – out of your EDL surrounded with the 
amount of frames chosen here, resulting in a timeline in your NLE.

3 Default colors and names for markers
Set up to 10 preset names and preset colors for your markers. These can be modified whenever 
needed before or after recording. The markers change depending on the setting in the "Video 
Editor" tab.
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LIVECUT PREFERENCES

PROJECT DEFAULTS7.10 

Sets the default folders for LiveCut. You will have to 
restart the LiveCut application and create a new project 
to take effect of these default settings.

LIVECUT PREFERENCES

WEB ASSISTANT7.11 

LiveCut has an integrated web server. Only enable this function if the Mac has enough resources left 
(especially CPU time). You can check the current load of your machine with the "Activity Monitor" 
application in the folder "/Applications/Utilities".

Once the "Web Assistant" is enabled you can click the 
"Open in Browser" button. The web browser checks your 
Bonjour connections and LiveCut will show up with the 
computer name. 

Predefined markers, sequence color (if supported by 
the selected NLE) and "good shot" can be set during the 
recording. You can use this on a mobile client like the 
iPad as well as any other web browser supporting the 
Bonjour service (which can also be installed on Microsoft 
Windows based clients).
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8 PROJECT SETTINGS:
Depending on the selected NLE, different project settings do apply. Final Cut Pro 7, Final Cut Pro X and 
Adobe Premiere have similar workflows which will be described together, Avid Media Composer will be 
explained separately.

PROJECT SETTINGS: FCP & ADOBE PREMIERE PRO

WORKFLOW USING FCP 7, FCP X OR ADOBE PREMIERE PRO8.1 

Press "cmd + p" to bring up the project settings. These settings do affect the Final Cut Pro XML. Some 
settings will be set once, others will change from take to take. All of them are active, meaning that every 
change effects the processing as soon as entered. These settings cannot be changed during recording.

Attention

Never change these settings after your recording has finished, as it effects the generating 
of QuickTime file names and other metadata. Doing so will result in errors in the XML 
generating or your media will be showing up offline in the Final Cut Pro or Adobe Premiere 
Pro project.

PROJECT SETTINGS: FCP & ADOBE PREMIERE PRO

PROJECT8.2 

1

3

4

2

5
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1 Name, Scene, Take
Used to identify and organize the project.

2 Color Selectors
Defines the label of the corresponding element when using Final Cut Pro 7 as NLE.

3 Bin Name, Sequence Name, Clip Name
Those three fields are variable fixed, meaning you can define a scheme on how to build up these 
names from variables. Please see the next chapter for further explanation.

4 Master Comment / "Good Shot" marker (only available in Final Cut Pro 7)
Enter your comments of the take. This information shows up in the Final Cut Pro master comment 
1 column. Usually this is entered in the main window, or after the recording in the stop-record 
window.

5 Add Good Shot to
The master comment can show up at various places in Final Cut Pro 7, choose at which ones you 
want them to show up.

PROJECT SETTINGS: FCP & ADOBE PREMIERE PRO

PROJECT: VARIABLES8.3 

A variable is indicated by a "%" in front and a colored background. Simply type in "%" and the variable 
word, then press the tab key to turn it into a variable. Variables can be rearranged using drag and drop. 
Fixed parts can be used by entering them without a leading "%".

%Name Corresponds to the "Name" field in the LiveCut main window.

%Scene Corresponds to the "Scene" field in the LiveCut main window.

%Take Corresponds to the "Take" field in the LiveCut main window.

%Date Corresponds to the current date (updated whenever a change is made in any field).

%Time Corresponds to the current time (updated whenever a change is made in any field)
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PROJECT SETTINGS: FCP & ADOBE PREMIERE PRO

PATHS8.4 

1

5

2 3

4

6

7

1 Filenames
Defines how the pattern of the file name is built in the just:in ingest application. Best is to leave 
this as shown, as it perfectly fits for most needs. In the drop-down box on the right you can 
choose the type of media wrapper.
 ρ For Final Cut Pro 7, Final Cut Pro X or Adobe Premiere Pro CS6, use ".mov".
 ρ For Avid's Media Composer 5.5-6.5, use ".mxf".

Please also read the note at the end of this chapter regarding the usage of MXF in FCP or Adobe 
Premiere Pro.
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2 High Res Media Paths
Choose the location of the high resolution QuickTime files. This folder is the main location for your 
media. This value is taken from the LiveCut preferences default settings, but can be overwritten 
here.

3 Proxy Media Paths
Choose the location of the low resolution proxy QuickTime files. This folder is the main location 
for your proxy media. This value is taken from the LiveCut preferences default settings, but can 
be overwritten here.

4 Proxy Suffix
Defines the proxy file name extension to easily identify the proxy. 

5 Final Cut Project
These settings handle the general export of the recorded take. Takes are immediately exported 
into a Final Cut Pro project file, whenever a recording is stopped or an export is initiated. The FCP 
project file can be set in advance, thus enabling the user the possibility of an automated delivery 
to different FCP project files. Example: If you want to create one FCP project per day, choose 
"Append to Final Cut Project" and set the name of the project file to "%Date". A new FCP project 
will be created for every day. Any recorded take during this day will be delivered into this project. 
Available variables include: %Name, %Scene, %Take, %Date, %Time.

6 High Res Directory
Export location of the high resolution XML file. This backup folder can act as a watch folder for 
Final Cut Server or other MAM-solutions. 

7 Proxy Directory
Export location of the proxy resolution XML file. This backup folder can act as a watch folder for 
Final Cut Server or other MAM-solutions.

Note

Using MXF files within Final Cut Pro 7 and Final Cut Pro X requires dedicated plug-ins like 
Hamburg Pro Media's MXF4Mac product line. Please check their website (http://http://
hamburgpromedia.com) for more information.
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PROJECT SETTINGS: FCP & ADOBE PREMIERE PRO

EXPORT OPTIONS8.5 

These settings do affect the generated timeline. We recommend not to change those settings, as Final 
Cut Pro's "Auto" settings are nearly bullet-proof.

1

2

3

4

1 Delay before export
Use this feature to leave some "safety time" for closing the write process of the new media. 
Depending on the length of your recording, the storage system might need some seconds to 
finish moving the file.

2 Use sound tracks from
Choose your main audio source to be tracklayed in the timeline.

3 Sequence starts at
Choose the start timecode for the sequence.

4 Sequence Settings
Choose the way Final Cut Pro handles the sequence. "Auto" works very well, even though multi 
codec recording may require manual settings. If this is the case, select the "Override sequence 
settings" radio button and define your own sequence settings below. Be aware that doing so, 
might affect your NLEs performance.

When you are done with your project setup, choose "Save Settings" in the "Project" menu. Name your 
template, and save it. You can select it whenever you launch LiveCut. You can create an unlimited 
amount of project templates. The templates are located in the folder "~/Documents/LiveCut Documents/
Project Templates" and can be copied between workstations.
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9 PROJECT SETTINGS: MEDIA COMPOSER
When using Avid's Media Composer 6.x.x, the workflow is slightly different. The main advantage when 
capturing MXF files using Avid's "atomar operational pattern" (OP Atom MXF) is that these files include 
a UMID (Unique Material Identifier) which handles all the relinking in Media Composer.

Press "cmd + P" to bring up the project settings. These settings affect the Avid AAF. Some settings will 
be set once, others will change from take to take. All of them are active, meaning that every change 
effects the processing as soon as entered. These settings cannot be changed during recording. 

Attention

Never change these settings after your recording has finished, as it as it will effect the 
generation of MXF file names and other metadata. Doing so will cause the AAF file 
generation to fail and your media will be declared as offline within the Avid project.

PROJECT SETTINGS: MEDIA COMPOSER

PROJECT9.1 

1

3

4

2

1 Name, Scene, Take
Used to identify and organize your project.

2 Color Selectors
Not available for Media Composer (Final Cut Pro 7 only).
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3 Bin Name, Sequence Name, Clip Name
Those three fields are fixed variables, meaning you can define a scheme on how to build up these 
names from variables. Please see the next chapter for further explanation.

4 Master Comment
Not available for Media Composer (Final Cut Pro 7 only).

PROJECT SETTINGS: MEDIA COMPOSER

PROJECT: VARIABLES9.2 

A variable is indicated by a "%" on a colored background. Simply type the variable identifier "%" followed 
by the variable's definition and press the tab key to create it. 
Variables can be rearranged using drag and drop. Fixed variables can be defined by leaving out the 
leading "%" sign.

%Name Corresponds to the "Name" field in the LiveCut main window.

%Scene Corresponds to the "Scene" field in the LiveCut main window.

%Take Corresponds to the "Take" field in the LiveCut main window.

%Date Corresponds to the current date (updated whenever a change is made in any field).

%Time Corresponds to the current time (updated whenever a change is made in any field)
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PROJECT SETTINGS: MEDIA COMPOSER

PATHS9.3 

1

2

1 Filenames
The "File Name" field defines how the pattern of the file name is generated within the just:in ingest 
application. Best is to leave this as shown, as it perfectly fits almost every need.

2 Media Path
When running Media Composer on the same machine you will have to capture in Avid's "Creating" 
folder. You cannot capture straight into the MXF-folder "1", as Media Composer will scan the 
folder immediately and put the file into quarantine as it is still growing. When the recording is 
finished, just:in can move the file from "Creating" to "1". Therefore a post record script is needed.

PROJECT SETTINGS: MEDIA COMPOSER

PATHS: MEDIA PATH POST RECORD SCRIPT9.4 

The post record script is located at: "/Library/Application Support/ToolsOnAir/Just In/Scripts" and is 
called "postrecord.sh". This is a shell script which is executed as soon as the recording is finished.

Open it using a plain text editor (like "Text Edit"), then append the following line to the existing two lines:

mv {SourceFolder}*.mxf {DestinationFolder}

Make sure to insert the proper folder names between the braces. This will move all MXF files from the 
source folder ("Creating") to the destination folder ("1"). We strongly recommend moving media only on 
the same media drive.

A workaround to capture to an arbitrary folder and moving the media to folder "1" while Media Composer 
isn't running. The media will relink fine after importing the corresponding AAF files.
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PROJECT SETTINGS: MEDIA COMPOSER

EXPORT OPTIONS9.5 

1

2

3

1 Delay before export
Use this feature to leave some "safety time" for closing the write process of the new media. 
Depending on the length of your recording, the storage system might need some seconds to 
finish moving the file.

2 Use sound tracks from
Choose your main audio source to be tracklayed in the timeline.

3 Sequence starts at
Choose the start timecode for the sequence.

When you are done with your project setup, choose "Save Settings" in the "Project" menu. Name your 
template, save it and you can select it whenever you launch LiveCut. You can create an unlimited amount 
of project templates. The templates are located in the folder "~/Documents/LiveCut Documents/Project 
Templates" and can be copied between workstations.
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10 LIVECUT MAIN WINDOW

Meta Timecode

Controller Status

Sw
itc

he
r

ED
L

Markers
1 2 3

4

5
6 7

1 Meta
Insert "Name", "Scene" and "Take" metadata here. This information will show up in all supported 
NLEs. The "Comment" and "Good Shot" markers are prompted again whenever you stop recording.

2 Timecode
Displays the currently running timecode from your selected source, as well as the duration of 
your sequence, the remaining recording time and the beginning of your sequence.

3 Markers
To bring up the markers drawer, open the "Markers" menu and select "Show Markers" (or use the 
keyboard shortcut "cmd + L"). Press the "+" at the bottom to set a new marker during the recording. 
A color and a marker name can be set, which show up in Final Cut Pro as well. Marker presets 
can be set in the LiveCut preferences. You can also use a web browser for setting markers (see 
chapter "Web Assistant" in the preferences chapter).

4 EDL
The recorded sequence, displayed in a EDL like style.

5 Switcher
Displays the current status of the switcher. In case of a dissolve, two buttons will be highlighted.

6 Controller
The "Start"/"Stop" button.

7 Status
Displays the connection status to external devices (timecode, USB interface) plus the status 
of the software (idle, recording). Red indicates a "ready-to-record"-status, yellow indicates no 
connection.
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LIVECUT MAIN WINDOW

LIVECUT AND BLACKMAGIC ATEM SWITCHERS10.1 

When using the Blackmagic ATEM series switcher, LiveCut changes the lower part of its user interface 
and displays the ATEM status and switcher controls.
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11 WORKFLOW: USING LIVECUT
WORKFLOW: USING LIVECUT

THE "AUTO COUNTER"11.1 

When you need to do a lot of takes every day, the "Auto Counter" will become your best friend. When 
LiveCut is launched, you will be asked to save a new file. Save it using "Name" and "Scene", LiveCut will 
add the "Take" to the filename.

If you followed the setup chapters earlier, then you're 
ready to go.. Click the "Auto Counter" checkbox to enable 
it. It will always use "1" as the first take, though you can 
change this setting by using the stepper arrows.

When the "Auto Counter" is disabled, you will have to manually clear the table and make LiveCut ready 
for the next take. Go to menu "Edit" and select "Clear Table" (keyboard shortcut: cmd + alt + shift+ T).

Before each take and whenever the recorder window is open, LiveCut checks if the filename already 
exists. When you manually clear the table, you will get a warning message that the filename already 
exists. Just change the "Name" or "Scene" or simply increase the take.

WORKFLOW: USING LIVECUT

THE "AUTO EXPORT"11.2 

The "Auto Export" feature automates the Final Cut Pro, Adobe Premiere Pro and AVID Media Composer 
export. This feature is always enabled. LiveCut will send the recorded take as XML or AAF into the "XML 
Backup" or "Exported AAF Projects" folders inside the "LiveCut Documents" folder.

By choosing either "Open in Final Cut Pro 7 or X", or "Adobe Premiere Pro" or "Avid Media Composer" 
in the "Project" menu you can open the take straight after the export on the local machine. If you want 
the take to be delivered to an external workstation, grab the XML file from the "High Res XML Backups" 
folder and drop it onto the Final Cut Pro or Adobe Premiere Pro application for import. When working 
with Media Composer, take the generated "AAF" file out of the exported AAF folder and send it to a Avid 
Media Composer workstation.
Please be aware that the original media files need to be accessable by the choosen NLE!
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WORKFLOW: USING LIVECUT

THE JUST:IN CHANNEL WINDOW11.3 

Before recording you need to choose the ingest channels. This is done by opening the just:in channel 
window. Open the "Window" menu and select the command "Just In Channels" or press "cmd + 2".

You should see the channels previews now,, where a red border indicates the currently selected channels. 
In the lower left and right of each preview you can see audio meters. Depending on how many audio 
channels you have chosen, a maximum of eight bars will be displayed (up to four bars on each side).

4 5 6

3

1

2

7

1 Channel Number

2 Timecode

3 Record / Ready for Record Info LED
Shows whether the channel is currently recording (red) or ready for record.

4 Capture all
Selects all channels.

5 Disable all
Deselects all channels.

6 Filename
Name of the file.

7 Icons
See next page.



address Zirkusgasse 39 | A-1020 Vienna | Austria | phone +43 (0) 1 236 8665 | mail info@toolsonair.com | website www.toolsonair.com 31tools ‡ air

1 2 3

1 Eye Icon
Takes you diectly to the high re file path

2 Play Icon
Open the file in QT player while capturing (works only in rec mode)

3 Magnifying glass
Enables/Disables Preview of the channel

WORKFLOW: USING LIVECUT

CHECKLIST BEFORE RECORDING11.4 

 ρ Check your ingest presets for all channels.
 ρ Check if the timecode is present in every channel in the recorder window and in LiveCut main window.
 ρ Check the "Status" area in the LiveCut main window: Orange = ready, red =  ready for recording.
 ρ Check if the "Auto Counter" is enabled.

If all these requirements are fulfilled, you can proceed and press the "Record" button in the main 
window of LiveCut.

While recording you cannot access the preferences anymore (until you stop the recording). When 
you press the "Stop" button, you will get a safety warning which asks you if you are sure to stop the 
recording and you can again select "Good Shot" and the sequence color (when using FCP 7 as NLE). 

 ρ Press "Keep Recording", if you want to go on with capturing.
 ρ It is possible to choose "Open after Export" while recording.

If you stop recording and the "Auto Counter" was not enabled before, you have to manually clear the 
table before recording your next take. To perfom that action go to the menu "Edit" and select "Clear 
Table" (keyboard shortcut: cmd + alt + shift+ T).
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WORKFLOW: USING LIVECUT

WORKFLOW11.5 

Enable the ingest channels you want to record and you are good to go. When 
you press the "Record" button in the lower right, LiveCut will do the following:

 ρ Create a new LiveCut file (in the LiveCut project folder)
 ρ Tell the ingest application to start recording
 ρ As soon as the ingest is in record mode it starts recording the EDL
 ρ When the "Stop" button is pressed it will stop the recording
 ρ LiveCut will increase the "Take" amount by 1, and then wait for the ingest to get ready again. (indicated 

in the status area)
 ρ When the "Record" button is pressed it will record the new take

We recommend to setup and test this feature to make sure you get the best out of this workflow. 
LiveCut turns into a single-button application when you use this feature. To disable the "Auto Counter" 
click its checkbox.
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12 KEYBOARD SHORTCUTS
cmd + E Export XML (also works while recording), Export AAF.

cmd + H Hide LiveCut

cmd + shift + H Hide others.

cmd + shift + L Show markers.

cmd + M Minimize window.

cmd + K Add unnamed marker.

cmd + P Project settings.

cmd + Q Quit LiveCut (does not apply while recording).

cmd + 2 Show recorder window.

cmd + 3 Show just:in channels.

cmd + 4 Show confidence window.

cmd + F Switch confidence window to full screen.

cmd + alt + Enter Start / Stop recording.

alt + 1…0 Set marker.

cmd + S Save project setting, make template.

cmd + W Close window.

cmd + , Open LiveCut preferences (does not apply while recording).

 
All of the shortcuts can be set as hot keys for various external control interfaces like:
 ρ http://www.piengineering.com/xkeys.php
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t 13 EXTRA FEATURES
EXTRA FEATURES

EXPORT: EDIT WHILE RECORDING13.1 

When using Final Cut Pro or Adobe Premiere Pro, you can export your takes while recording. In the Avid 
workflow this is not possible because Avid MXF files have no growing file support.

You can export by using the "Export to XY" command in 
the "Project" menu (where XY is your selected NLE) or by 
using the keyboard shortcut "cmd + e".

You are also able to export only parts to your NLE by highlighting them with your mouse and then using 
the context menu/right click "Export to …".

For both methods following rule applies: If you have chosen "Open in XY after Export" (where XY is 
your selected NLE), the XML file is created in your High Res XML Backup folder, then opens your NLE 
and imports the XML.

The same method works with markers. When the marker drawer is opened you can export single or 
multiple selected markers with a right mouse click. This feature becomes handy when you need to work 
on a given part of the timeline due to special requirements or time issues.

Note

Keep in mind that Edit while Recording only works in a proper setup and with enough 
CPU power headroom left for LiveCut and the ingest. 

EXTRA FEATURES

PROJECTS13.2 

You can reopen LiveCut projects at any time after your recording or change your export options to re-
export it, for example with a different soundtrack as the selected main source.
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EXTRA FEATURES

EDL (ONLY FOR FINAL CUT PRO AND ADOBE PREMIERE PRO)13.3 

With your vision mixer or GPI simulator it is possible to switch to a source that doesn´t exist. To do 
this, set up one channel (or more) in the LiveCut preferences under the I/O device matrix and try it out. 
You will experience that, every time you switch to this non existing source, you get a "gap" in your video 
track. This can be perfect for inserting special graphics or other prepared video layers.

EXTRA FEATURES

CAPTURING ADDITIONAL PROXY FILES13.4 

You can – apart from your high res files – capture additional proxy files. This workflow needs much 
more CPU and disk performance and should not be activated by default. It is only available when 
using just:in destination presets and includes proxy export. If your workflow requires additional proxy 
recording, please contact the ToolsOnAir support to discuss that particular setup.

Proxy files are always captured in Photo JPEG codec sized 352x288 in PAL or in NTSC correspondingly.
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14 KNOWN ISSUES
 ρ If you change the USB settings it is required to click the "Apply" button and restart the application, 

otherwise the settings will not take effect.
 ρ Do not disconnect the GPI box while using LiveCut, otherwise LiveCut will unexpectedly quit.
 ρ If LiveCut – despite of checking all settings – does not behave correctly, restart the application or 

restart your Mac.
 ρ If – for some reason – you cannot stop your recording or the just:in engine hangs or unexpectedly 

quits, this does not necessarily mean that you have lost your recording.
 ρ Check if your captured files are being created and verify if they are properly playing in the QuickTime 

player.
 ρ Open your automatically saved LiveCut project located at "~/Documents/LiveCut Documents/Projects" 

and re-export it to your NLE. Very likely it will work.
 ρ When importing XML into Final Cut Pro 7 it states "uncritical errors while importing the XML". This 

message has no further effects and can be disregarded.
 ρ Final Cut Pro 7 sometimes does not open the XML when receiving it from LiveCut. If this is the case 

you need to log out and in again, or import it manually.
 ρ When LiveCut wants to export a take it needs to check the files. Therefore you must ensure that 

LiveCut can read the files properly. If you are running the ingest and LiveCut on the same machine, 
it usually can read the files. In case you have LiveCut and the ingest separated, then either you have 
to have a SAN or you share the ingest folder with your LiveCut controller Mac. Contact support@
toolsonair.com for additional information.

When using proxy files in FCP 7 you need to set the pixel aspect ratio to either "PAL" or "NTSC" and set 
the sequence and files to anamorphic.

15 TOOLSONAIR HELPDESK
Administrators and users are able to use the  ToolsOnAir 
online helpdesk. The helpdesk provides frequently asked 
questions, current software installer packages and more 
supplemental documents like user manuals and data sheets. 
You can also report bugs or submit feature requests to our 
developers and engineers.

http://support.toolsonair.com/


